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The software described in this document is furnished under
license agreement. The software may be used only in accordance
with the terms of the license agreement. No part of this User’s
Guide may be reproduced or transmitted in any form, by any
means, electronic or mechanical, including photocopying and
recording, for any purpose without the express written consent of
Grolier Electronic Publishing, Inc.
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The views expressed in Pathmakers are not necessarily those of
the publisher. They represent the opinions of individual experts
and have no bearing on the factual content of the encyclopedia.
Pathmakers are presented as a thought-provoking introduction to
broad fields of interest — and for unique perspectives on
individual achievement and the creative process.

The 1995 Grolier Multimedia Encyclopedia contains copyrighted
materials which are licensed to you, the end user, for your
personal use subject to the terms of the accompanying license
agreement. You must treat this software and its contents like any
other copyrighted material, such as a book or musical recording.
Any other use, duplication, or distribution of this product or its
contents may violate applicable U.S. or international copyright
laws, and may subject you to prosecution under penalty of law.
The following are prohibited by law: any theatrical, televised, or
public display or performance, including transmission of any
material over a computer network; the preparation of any
derivative work, including the extraction in whole or in part, of
any material without the permission of the copyright owner.

Copying, Printing, and Saving

The 1995 Grolier Multimedia Encyclopedia includes Copy, Print,
and Save features which allow you to copy, print, and save text
and images. These features are provided for your personal use of
the product. As an example, you might wish to copy information
from a particular article into an electronic research file for later
reference, or you might wish to print an image to view at a time
when you are away from your computer. However, copyright law
does not allow you to copy or print an article or image for
commercial publication or use, or for distribution on a computer
network. These examples are illustrative only, and are not meant
to summarize applicable law.

Academic Citations
Any direct quotations from The 1995 Grolier Multimedia

Encyclopedia should be accompanied by a footnote containing
the following information:

¢ The name of the author of the article, if present in the article.
e The title of the article.

* The Academic American Encyclopedia (Electronic Version),
copyright © 1995 Grolier, Inc., Danbury, CT.

License Agreement, Limited Warranty, and
Disclaimer

PLEASE READ THIS LICENSE CAREFULLY BEFORE USING THIS
SOFTWARE.

By using this software, you are agreeing to be bound by all terms
of this License. If you do not agree to the terms of this License,
promptly return the unused software and its complete package to
the place where you obtained it.

License

In consideration of payment of the License fee, which is a portion
of the price you paid, the software and data accompanying this
License (the “Software”) and related documentation are licensed
to you by Grolier Electronic Publishing, Inc. and its co-licensers
(hereafter collectively referred to as GEP). This non-exclusive
License gives you the right to use and display this copy of the
Software. You own the compact disc on which the Software is
recorded, but GEP and its co-licensers retain full and complete
title to the Software on that disc and the accompanying
documentation. Since this software is shipped on a read-only
medium (a compact disc), there is no need for backup or archival
copies of the Software to be made. You are not permitted to copy
the Software off that compact disc, beyond the installation of the
Software as done by the Software itself, to any storage medium.
This License shall not be considered a “sale” of the Software. This
License allows you to use the Software on a single computer at a
single location at any one time.

Restrictions

The Software provides you with the ability to save and print
specifically selected information contained within the Software.
You may exploit these features, where such capability is provided
for within the Software, for your personal, non-commercial use
only, preserving all copyright notices that are embedded by the
Software within those printed elements. The Software contains
copyrighted material, trade secrets, and other proprietary material
and in order to protect them you may not decompile, reverse
engineer, disassemble or otherwise reduce the Software to a
human-perceivable form. Except as provided for in this license,
you may not copy, modify, network, rent, lease, or otherwise
distribute the Software; nor may you make the Software available
by “bulletin boards,” online services, remote dial-in, or network
or telecommunications links of any kind; nor may you create
derivative works based upon the Software in whole or in part.
You may not electronically transmit or remotely operate the
Software by any means, nor may you use the Software over any
type of network. Within the terms of this license agreement,
Licensee may transfer all of the license rights to the Software to
another party providing that the original compact disc containing
the Software, the related documentation, all copyright notices,
and a copy of this License are transferred to that party, and
providing that party reads and agrees to accept the terms and
conditions of this License.




Software Updates

Updated versions of the Software may be created by GEP from
time to time. Licensee acknowledges that GEP is not responsible
nor liable for support, maintenance or the provision of any new
releases, enhancements or updates to the Software. GEP may at
its sole discretion make updates available to registered Licensees
who have paid the update fee.

Termination

This License is effective until terminated by either party. You may
terminate this License at any time by returning the Software to
GEP or destroying it and all related documentation and all cop.es
and installations thereof, whether made under the terms of this
License or otherwise. This License will terminate immediately
without notice from GEP if you fail to comply with any provision
of this License. Upon termination, you must destroy or return to
GEP the Software and related documentation and all copies
thereof, whether made under the terms of this License or
otherwise.

Limited Warranty and Disclaimer

GEP WARRANTS THE DISC ON WHICH THE SOFTWARE IS
RECORDED TO BE FREE FROM DEFECTS IN MATERIALS AND
WORKMANSHIP UNDER NORMAL USE FOR A PERIOD OF NINETY
(90) DAYS FROM THE DATE OF PURCHASE AS EVIDENCED BY A
COPY OF THE SALES RECEIPT OR PACKING SLIP. GEP'S ENTIRE
LIABILITY AND YOUR EXCLUSIVE REMEDY WILL BE REPLACEMENT
OF THE DEFECTIVE DISC WHICH iS RETURNED TO GEP WITH COPY
OF PROOF OF PURCHASE OR DELIVERY. GEP WILL HAVE NO
RESPONSIBILITY TO REPLACE A DISC DAMAGED BY ACCIDENT,
ABUSE OR MISAPPLICATION. ANY IMPLIED WARRANTIES ON THE
DISC, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABIL-
ITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN
DURATION TO NINETY (90) DAYS FROM THE DATE OF PURCHASE
OR DELIVERY. THIS WARRANTY GIVES YOU SPECIFIC LEGAL
RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY
FROM JURISDICTION TO JURISDICTION. YOU EXPRESSLY
ACKNOWLEDGE AND AGREE THAT USE OF THE SOFTWARE IS AT
YOUR SOLE RISK. THE SOFTWARE AND RELATED DOCUMENTA-
TION ARE PROVIDED “AS IS" AND WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESS OR IMPLIED. GEP AND ITS CO-LICENSERS
EXPRESSLY DISCLAIM ALL WARRANTIES, EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
GEP DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN
THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR
THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED.
FURTHERMORE, GEP DOES NOT WARRANT OR MAKE ANY

REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE
USE OF THE SOFTWARE AND RELATED DOCUMENTATION IN
TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR
OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE BY
GEP OR A GEP-AUTHORIZED REPRESENTATIVE SHALL CREATE A
WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS
LIMITED WARRANTY. YOU (AND NOT GEP) ASSUME THE ENTIRE
COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF
IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT
APPLY TO YOU.

Limitation of Liability

Under no circumstances, including negligence, shall GEP be liable
for any special or consequential damages that result from the use
of, or the inability to use, the Software or related documentation,
even if GEP or a GEP authorized representative has been advised
of the possibility of such damages. Some jurisdictions do not
allow the limitation or exclusion of liability for incidental or
consequential damages, so the above limitation or exclusion may
not apply to you. In no event shall GEP's total liability to you for
all damages, losses, and causes of action (whether in contract,
tort [including negligence] or otherwise) exceed the amount paid
by you for the Software.

Government Use

If you are acquiring the Software on behalf of any unit or agency
of the United States Government, the following provisions apply.
The Government agrees: i) if the Software is supplied to the
Department of Defense (DoD), the Software is classified as
“Commercial Computer Software” and the Government is
acquiring only “restricted rights” to the Software and its
documentation as that term is defined in Clause 252.227-
7013(c)(1) of the DEFARS; and ii) if the Software is supplied to any
unit or agency of the United States Government other than DoD,
the Government's rights in the Software and its documentation
will be defined in Clause 52.227-19(c)(2) of the FAR or, in clause
18-52.227-86(d) of the NASA Supplement to the FAR.

Exporting

You agree and certify that neither the Software nor any other
technical data received from GEP, nor the direct product thereof,
will be exported outside the United States except as authorized
and as permitted by the laws and regulations of the United States.
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Governing Law and Severability

The License shall be governed by and construed in accordance
with the laws of the United States and the State of Connecticut. If
for any reason a court of competent jurisdiction finds any
provision of this License, or portion thereof, to be unenforceable,
that provision of the License shall be enforced to the maximum
extent permissible so as to effect the intent of parties, and the
remainder of this License shall continue in full force and effect.
This is the entire agreement between the parties relating to the
subject matter herein and shall not be modified except in writing,
signed by both parties.

Replacement Policy

If any component of The 1995 Grolier Multimedia Encyclopedia
arrives in damaged or defective condition, it will be replaced free
of charge. Simply return the damaged or defective component
within 90 days of purchase, and enclose proof of purchase. After
the 90-day period, a damaged or defective disc can be replaced
by returning it with a check for $25.00 plus $5.00 shipping and
handling to Grolier Electronic Publishing. Lost or stolen discs can
be replaced by sending a proof of purchase to Grolier Electronic
Publishing with a check for $74.95 plus $5.00 shipping and
handling.

Additional User’s Guides

Additional User’s Guides are available for $15.00 each plus $5.00
shipping and handling.
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Chapter 1:

Getting
Started

Using this guide

Welcome! The 1995 Grolier Multimedia
Encyclopedia (the GME) is a CD-ROM containing
the complete text of all 21 volumes of Grolier’s
Academic American Encyclopedia, plus pictures,
maps, animations, videos, timelines, sounds,
and much more.

This User’s Guide consists of the following
chapters:

1 8

Getting Started tells you what you need to
run the GME and how to install it on your
computer.

10-Minute Tour guides you through the
basics of searching, reading articles, using
the multimedia features, and viewing Maps,
Timelines, and Pathmakers.

. Research Tools and Techniques describes

using more sophisticated search tools, using
electronic bookmarks, editing with word
processors, saving to disk, and printing.

Appendixes contain everything else you
might need to know, including how to get
technical support.

Items in the margins
contain technical
notes or other
asides that are
informative but not
essential to using
the GME.
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What's new in the 1995 GME?
The 1995 GME has many important
enhancements over previous versions:

e More than 5,500 articles have been added
or updated to reflect world developments
in the past year.

* Thousands of new illustrations and
photographs have been added, as well as
new animations and Knowledge
Explorer essays.

¢ A new feature called Pathmakers helps you
explore the GME in new ways.

e Graphical timelines present civilizations and
major trends along with important events.

Package contents
The 1995 Grolier Multimedia Encyclopedia
includes the following:

* A CD-ROM containing the complete text of
all 21 printed volumes of Grolier’s Academic
American Encyclopedia, plus additional
articles written specifically for the GME.
There are nearly 33,000 articles with
comprehensive indexes of all the articles,
pictures, maps, and multimedia features.

e This User’s Guide, which features step-by-
step instructions for using the GME.

¢ A Warranty Card for registering your copy

of the GME. In order to receive the best
service possible, you must register. So before
doing anything else, please complete and
return the warranty card or call

(800) 285-4535.

Getting Started

System Requirements

Most Macintosh computers sold in the last few
years easily meet or exceed the GME’s system
requirements. If you’re not sure if your
Macintosh does, don’t worry. Just try using the
GME. 1f something doesn’t work the way it’s
supposed to, consult this list and check the
troubleshooting instructions in Appendix C.
The GME requires the following:

¢ A Macintosh LC II (16-megahertz 68020

central processing unit) or better

System 7.0 or higher

2 megabytes of unused memory

A hard disk with 5 megabytes of free space

A 12-inch or larger monitor capable of

displaying at least 16 colors or shades of gray

e A CD-ROM drive with throughput of 150
kilobytes per second or greater (slower drives
will work, but QuickTime videos won't play
as smoothly)

¢ A Macintosh-compatible printer (optional)
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Installing the GME

1. Put the disc with the label side up in your
CD-ROM drive.

2. Double-click the GME95 CD-ROM icon on
your desktop.

3. Drag the folder GME9S to your hard drive.

4. Open the folder entitled Put Contents in
System Folder and drag QuickTime to the
System Folder on your hard disk. You will be
prompted to put QuickTime in the
Extensions folder. Click OK to put it there
automatically.

5. Open the GME 95 folder on your hard disk
and double-click the GME icon to launch the
program.

Note: As stated in the system requirements,
you must have System 7.0 or higher installed
on your Macintosh to run the 1995 GME. The
GME installation will not work without it.

Chapter 2:

10-Minute
Tour

This chapter gives you a guided tour to get you
up to speed with the powerful, interesting, and
entertaining features the GME offers. You'll
learn how to look up articles by title, search for
items containing particular words, listen to
sounds, view pictures, watch videos, explore
maps, navigate timelines, and much more.
Devoting your first session to completing this
tour helps you understand the basic concepts of
the program and gives you a feeling for the
wealth of information you now possess at your
fingertips.

Help is always available from the Help menu
and via Help buttons that appear on some
screens.

Help...
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Title screen and Main Features screen
When you first launch the GME (by double-
clicking the Grolier Multimedia Encyclopedia

icon), a registration reminder appears. Click OK.

The Title screen appears as the application
loads.

/Ay [T
_ Ik SV

AT AT A 2 0 DA b S R R

GROLI ER

MULTIMEDIA ENCYCLOPEDIA

Designed, Produced and Published by Grolier Electronic Publshing. Inc
Copyright ©1994 Grolier Electronic Publishing

' ~‘R s
e R e

When loading is complete, the Title screen is
replaced by the Main Features screen.
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10-Minute Tour

The Main Features screen contains 12 buttons
which take you to the main features of the
GME. When a button is clicked, the Main
Features screen closes automatically and the
selected feature appears along with the toolbar.
But don’t worry. Even if the Main Features
screen is hidden, you can still access all of the
same items by choosing from the menu bar or
using the toolbar. See for yourself by clicking
any of the buttons on the Main Features screen.

Toolbar

In addition to opening the desired feature,
clicking any of the buttons on the Main
Features screen automatically closes the Main
Features screen and replaces it with the toolbar.
The toolbar provides direct access to the most
popular features.

Word Search
see pages 11 & 30

Word Search on

Article Title List
see page 8

Hyperlink to Selection Selection

see page 36 see page 36
Pathmakers Knowledge Tree
see page 26 see page 20

Timelines Maps
see page 23 see page 19

Multimedia Maps Pictures
see page 17 see page 15
Sounds Videos
see page 16 see pages 16 & 60
Animations Knowledge Explorers
see page 16 see page 18
Word Processor Add Bookmark
see page 40 see page 36
Print Save

see page 43 see page 44

You can disable the
display of the
registration
reminder and Main
Features screen by
choosing
Preferences from
the Edit menu and
unmarking the
appropriate
checkboxes.

You can move the
vertical toolbar
wherever you like
so that it doesn't
obscure anything of
interest; just click its
title bar and drag to
a new location.
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There are many
ways of
accomplishing a
given task in the
GME. From now on,
for simplicity’s sake
the User’s Guide
assumes you're
using the toolbar,
but keep in mind
that you can click
the corresponding
buttons on the
Main Features
screen or choose
commands from the
menu bar if you
prefer.

Most of the toolbar buttons are functionally
equivalent to buttons on the Main Features
screen. The exceptions are Hyperlink to
Selection, Word Search on Selection, Word
Processor, Add Bookmark, Print, and Save.
Clicking one of these buttons is functionally
equivalent to choosing the command of the
same name from the menu bar. If a tool or
command is dimmed, it’s not available. For
instance, some tools are available only when
articles are open.

Browsing article titles

Let’s start our tour with the assumption that
you're researching President Lincoln’s position
on slavery in the United States. To find out if
there is an article on slavery in the
encyclopedia, open the Title List by clicking the
Title List button on the Main Features screen or
toolbar, or by choosing Title List (Command-I)
from the View menu.

mE— pmE |

Title to Find
[ [ stavent enter subject here
slavery - click to scroll
Slavic languages up one line
Slavic mythology
Slavonia L click to scroll
Slavophiles and Westernizers up one page
Slavs
Slayton, D. K L drag to scroll freely
sled ‘
sleep - click to scroll
down one page
I ciear | | view | [ click to scroll
} down one line

click to clear text box click to open selected item

10-Minute Tour

The Article Title List contains the names of
every article contained in the GME. It’s useful
when you know exactly which article you're
looking for.

Begin typing the word slavery in the Title to
Find text box. Notice that as soon as you start
entering characters, the highlight in the scroll
box moves to the closest match. This feature is
known as Speed Scroll.

If Speed Scroll hasn’t selected the article you
want, click any title or use the mouse to drag
the scroll box. Neither method changes the
selection; just the view on the contents of the
scroll box is affected. This means that the
selection may not always be visible in the scroll
box. To change the selection, click a new title.

As soon as the title you want is selected, click
View or press Return or Enter to open the
article. Alternatively, you can double-click a
title in the scroll box.

Remember that
people are listed
last name, first
name.
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button bar

Slavery is a societal institution based on ownership, dominance, and exploitation

of one human being by another. The owner may exact work or other services

without pay and virtually without restriction and can deny the slave freedom of

activity and mobility. Generally the owner is responsible only for providing

minimal food, shelter, and clothing. The owner may separate members of a family

and may pemit or deny marriages. A slave is commonly regarded as an article of

property, or chattel, and therefore can be sold or given away. Slaves do not come scroll
under the jurisdiction of laws that protect citizens, although special regulations bar
may stipulate their reatment and behavior

Slavery has appeared almost universally throughout history among peoples of
every level of material culture--from ancient Greece orthe United States inthe
18th century to various African and American Indian societies. Slavery is not
unique to any particular type of economy. It existed among nomadic pastoralists
of Asia, hunting societies of North American Indians, and sea people such as the
Norsemen, as well as in settled agricultural groups, although the slaves

Ll (e

When an article opens, the cursor appears at the
beginning of the text. You can use the vertical
scroll bar to scroll the article. One way to find
out if this lengthy article contains a section
devoted to Lincoln is to click the outline button
on the button bar to look at all the headings
and subheadings of this article.

S|aVe ry EO==——— outiine: slavery
Slavery is a soc
of one human bei stavery [
without pay and vi SLAVERY IN THE ANCIENT WORLD
activity and mobili SLAVERY IN THE MIDDLE AGES
minimal food, sheft SLAVERY IN THE NELW WORLD
and r::;/ pem\hlt&)r’ The African Slave Trade
property, or chattel | n
o] | e Saghe Colonies
may stipulate their 9
OPPOSITION TO SLAVERY
Slavery has appeal SLAVERY DURING THE 20TH CENTURY
every level of matel 2
18th century to vari
unique to any parti I
of Asia, hunting so I nomj l -
Norsemen, as well — =T
< ) [ outiine

10-Minute Tour

The article remains open and visible behind the
outline. If you see a section heading that
interests you, double-click that heading and the
cursor automatically jumps to the beginning of
that section in the article. Unfortunately, it
doesn’t look like the slavery article has a section
dealing specifically with Abraham Lincoln.
Don’t despair. There’s another way of finding
exactly the Kind of articles for which you're
looking.

Searching for words and phrases

Whereas the Article Title List allows you to find
an article whose title begins with a particular
word, Word Search enables you to locate all
articles containing a single word or various
combinations of words. Article Title List is like
going to the video store and asking for a
particular movie by name; Word Search is like
requesting all comedies starring Bob Hope. As
such, it’s much more useful when you’re
interested in a particular subject but aren’t sure
where it might be located or what it’s called.

Click the Word Search button on the toolbar to
open the Word Search dialog box.

enter the word(s) to locate click to expand the dialog box

|

E Word Search
Text to Find
’(| slavery
[ Wew...| [ meset | [ cancet| [ Fina |
| : 2|

| | |

click to open a click to clear  click to close click to display
Help window  the Text to this dialog box  a list of terms

explaining the  Find box without initiating that meet the

options in this a search search criteria

dialog box

11
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The GME isn't case-
sensitive, so you
needn’t enter
capital letters when
searching.

Another way to
refine your search is
to click More
Choices to expand
the Word Search
dialog box. See
Chapter 3 for
details.

12

In the Text to Find box, enter the word slavery
and click Find or press Return to see the Search
Results list of all the items containing that
word. They are listed in order of their relative
importance.

SO Emmm=——== Search Resulls |

1]

-"i;li‘iiwiil‘>:vr - S = ..7 0% 5 ) v:V
black Americans

B civilwar, US

Compromise of 1850

Garison, William Lioyd

popular sovereignty
[B Arica, history of
Maya i

[ose] = [ew]

As you can see, there are many articles
containing the word “slavery.” But not all of
these articles are relevant to Lincoln’s position.
To narrow the search to more pertinent articles,
click the close box and click the Word Search
button again.

In the Text to Find box, enter slavery and
Lincoln, then click Find to locate all of the
articles containing both words.

Word Search

Text to Find

Islmru snd lincoln IW‘WI

Search Results

Bl Lincoln, Abraham

Civil War, US

United States, history of the
Douglas, Stephen A

black Americans il
Republican party |
slavery il
B Johnson, Andrew
Emancipation Proclamation
abolitionists

Clear l Uiew

Tio
l

<L

10-Minute Tour

This new search locates fewer articles, but all of
them contain the words Lincoln and slavery, so
there’s a better chance that they are relevant to
your research. Since you have already opened
the slavery article, double-click Lincoln,
Abraham to see what that has to offer.

Lincoln, Abraham Feeee—o————Uc

territory, but he opposed any expansion that would allow slavery into new areas;
hence, he supported the WILMOT PROYISO, which would have barred slavery
from any territory gained as a result of the Mexican War. He did not run for
Congress again, returning instead to Springfield and the lavy.

The Slavery Issue and the Lincoln-Douglas Debates

Lincoln "was losing interest in politics” when the KANSAS-NEBRASKA ACT was
passed by Congress in 1854. This legislation opened lands previously closed to
shavery to the possibility of its spread by local option (popular sovereignty),
Lincoln viewed the provisions of the actas immoral. Akhough he was notan
abolitionist and thought slayery unassailably protected by the Constitution in
states where it already existed, Lincoln also thought that America’s founders had
put slavery on the way to “ultimate extinction” by preventing its spread to new
territories. He saw this act, which had been sponsored by Democratic Senator
Stephen A. DOUGLAS, as a new and alarming development.

Lincoln vied for the U.S. Senate in 1855 but eventually threw his support to
Lyman TRUMBULL. In 1856 he joined the newly formed REPUBLICAN PARTY,

Il INI
| next occurrence
previous occurrence

When the article opens, all of your search words
are automatically underlined, and the cursor is
automatically positioned at the beginning of
the article. Click the buttons along the bottom
left of the window to jump to any occurrences
of your search words. These controls allow you
to quickly find the passages of an article dealing
with the subjects in which you’re interested. If
you didn’t use Word Search to locate an article,
these controls are dimmed and can’t be used.

13
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Looking at multimedia items

As you've learned so far, the GME allows you to
search the entire text of a huge multi-volume
encyclopedia in seconds. But the GME offers
much, much more. For example, look at the
button bar at the top of the article on Abraham
Lincoln. Each article’s button bar reflects the
features available with the article. The article on
Lincoln has Factbox, Outline, Pictures &
Sounds, and Multimedia Map buttons. You've
already seen what the outline looks like, so look
at the other items one at a time.

Click the Factbox button on the button bar to
see important, frequently-cited statistics on
Abraham Lincoln. As with the outline, the
Factbox displays in a separate window in front
of the article.

E[I===———=——=—=—== Fac!tBox: Lincoln, Abraham Eses

Facts About Abrah: Li
Abrabam Lincoln |55 cnote onted

States (1861-65)

Nickname: "Honest Abe”,
“Illinois Rail-Spliter”

Born: Feb. 12, 1808, Hardin
(now Larue) County, Ky.

Profession: Lawyer

State of &irth

Religious Affiliation: None
1789 present

Marriage: Nov. 4, 1842, to

Ty SR Mary Todd (1818-82)

of the Usiited States Children: Robert Todd Lincol
(1861-65) (1843-1926); Edward Baker
Lincoln (1846-50), William

!“p) C : g Wallace Lincoln (1850-62),

click for related article

10-Minute Tour

There are Factboxes for all U.S. Presidents, U.S.
states, Canadian provinces, countries of the
world, and continents. After you're done with
the Lincoln Factbox, return to the article by
clicking the close box or by clicking the Article
button in the lower left corner.

Back in the Lincoln article, click the Pictures &
Sounds button on the button bar. A list appears
from which you can choose an item of interest.

[ECJ=== Ppictures & Sounds: Lincoln, Abraham ===

0 Lincoln, Abraham iti
@8 Lincoln and His Cabinet

i@ Lincoln and his generals

8 Lincoln debating Stephen Douglas

Signing of the Emancipation Proclamation

[

click to open selected item

The icons to the left of the names in the list
indicate whether an item is a sound or a picture.
Every sound has a related picture (but not vice
versa), so this is really a list of pictures, some
with sounds attached.

Elsewhere you may
encounter lists with
different icons
indicating the
various kinds of
items available in
the GME: videos,
maps, animations,
etc. Regardless of
the contents, all list
windows work in a
similar fashon.

15
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Animations and
videos also use
standard QuickTime
windows, but their
controls are active.

16

[E0E===== LincoIn, Abraham ===

l'rﬂ\[':‘ 1

open

open Title 1
caption

List of
related articles

play sound

adjust
speaker
volume s | | JeH—drag to resize

close SE1=== Caption: Lincoln, Abraham window

caption Abraham Lincoln, portrayed here (1887) by F
George Peter Alexander Healy, was the 16th
president of the United States (1861-65) and,
according to many historians, the greatest
American president. Lincoln guided the country
through the devastating experience of the

Pictures with sound are displayed in a standard
QuickTime window. To hear the sound (if any),
click the Play button. You can adjust the
volume by clicking the speaker icon in the
lower left and dragging to a new level. Pictures
without sound are displayed without a control
bar.

Whenever you open a picture, its caption opens
too. After reading it, you can close a caption by

clicking its close box. Another way of closing a
caption is to close the window with which it’s
associated. Similarly, Factboxes, Tables, and

Outlines also close when you close their related

article windows.

10-Minute Tour

You can have as many windows open as you
wish, although things can get confusing when
you have a lot of overlapping windows. The
Window menu is a handy way of getting back to
an open window that’s obscured by other items
on the screen. Just choose from the list of open
windows at the bottom of the Window menu
and your choice pops to the front. For now, let’s
return to the article on “Honest Abe” by
choosing Lincoln, Abraham from the Window
menu.

Back in the Lincoln article, click the Multimedia
Maps button on the button bar to open the
Civil War Multimedia Map. Multimedia Maps
use text, maps, and sound to depict important
events in history. A table of contents will appear
on the right side of the window.

Table of contents
click a chapter title to

linked articles  caption position movie at beginning
button button of selected segment

Table of Contents
The South Secedes
War Begins, 1861
Battles in 1862
Battles in 1863
Battles in 1864
The South Surrenders, 1865

&

CIVIL
WAR

1860-65 | |

T

CT 1 - - | E]\Pnuse at end of chapter.

play/pause play bar rewind end-of-segment
volume fast forward pause check box

D)
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Most Knowledge
Explorer essays and
Pathmaker videos
also use extended
windows like those
used for Multimedia
Maps.

18

Click the Play button to start the Multimedia
Map. As it plays, the selection in the table of
contents changes to reflect what'’s being
illustrated in the Multimedia Map. To jump to a
particular subject, click its heading in the table
of contents.

If you click the Articles button in the upper left
corner, a Title List appears with the names of
articles related to the current segment. As the
Multimedia Map plays and the heading
changes, so do the related articles.

The controls along the bottom of the window
work just like those on a VCR, allowing you to
adjust the volume, play/pause, rewind, fast
forward, and move around by dragging the play
bar. As the Multimedia Map plays, you can
pause by clicking once anywhere inside the
window, or by clicking the Pause button. Click
again to resume playing. When you’re finished,
click the close box.

Exploring the globe

By now you could probably use a break to get
your mind off Abraham Lincoln. How about
taking a quick trip around the world? Click the
Maps button on the toolbar to open the Map
Categories window.

ﬂk@“iﬂwﬂﬁpﬂ-

COUNTRIES COUNTRIES
olvnxi\\l\ . OF ASIA

Eﬂ&(ﬁ‘“EZIB

CANADIAN COUNTRIES

PROVINCES

ﬂ(@
=

STATES OF COUNTRIES
THE USA THE WORLD F EUROPE

mg'ﬁi" w.ég.;“qggﬁ
il N SR .:.:’::::;:; e E
. P

OF THE
AMERICAS

The Map Categories window graphically
displays the broadest categories for all maps in
the GME. Other multimedia items have their
own category windows, and each allows you to
narrow the search to the items that most
interest you. Once you’'ve learned how to use
one category window, you've learned them all.

Click The World to open the map of the entire
world, or if you'd like to see someplace in
particular, click the button that corresponds to
your interests. If you're interested in American
geography, click States of the USA to open an
index showing all of the maps associated with
the United States of America.

10-Minute Tour

&

You can turn off the
display of category
windows by
choosing
Preferences from
the Edit menu and
unmarking the
Show category
index windows
checkbox. This
causes index
windows (see
following figure) to
appear instead of
category windows.

19
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The Knowledge
Tree is a special
index that allows
you to access the
GME'’s articles
through a hierarchy
of topics and
subtopics. It's nearly
the complete
encyclopedia in
outline form! Take
time to explore this
important research
tool.

20

Click to select an item or
double-click to retreat to the

Click to view the selected item
or advance to the next level.

10-Minute Tour

selected level of the hierarchy.

IDE% Maps é

OMape GO
© States of the USA « Delaware

* Florida

« Georgla

« Hawaii

* Idaho

« lllinois

« Indiana

« lowa

+ Kansas

« Kentucky

+ Louisiana

* Maine

* Maryland

+ Massachusetts

[ cancer | | view'|

Click to select an item. Double-click to view an item or advance down
to the next level of the hierarchy (i.e., view a category).

Indexes are used to select and access items of
interest using an outline navigation system.
Each index window is divided in half vertically
with the index name and broad categories on
the left and subcategories and individual items
on the right. Categories are preceded by either
an open or closed pointer, whereas items are
indicated by bullet points.

Double-click a subcategory on the right and
continue double-clicking until you see an item
you want to open, then double-click the name
of the item to open its window.

e —Qmry- |
© Maps « Connecticut
o States of the USA « Delaware
= Elorida
F0ES==—————— Connecticut 2]
73R W 73 W 72°30' W MASS. 72°W <)
®Ca } r T Y]
T tnfieid ¢ SuAfford .
Winsted (® [SPipdse Putnam g
Cornwall 1 .
NEW Bridge  Torrington / esStorrs R.L.
'YORK o/ e East Hanio& @Manchester
; . o @ =
Ueentiold® . WestHarddd OXHartford o .. dniic
Bristolg ) . t
New New Britain® ;gmﬂr'ﬂ""l \
oMiltord Middlatown, Colchester N
wnerbury | Merlden. x 4 '\ 7.bh_)(wi:h 41°30" N
Naugatuck® ™ Montville

eDanbury _@Hamden

Chestar .\ *

E“.':\& Lonb:iec‘:o M”E/
Shelton g eNew Haven ] iy )‘}

P
Trumbull W, H-v.n,/‘;.il!j_i'/\"" N "Old Saybrook C7

Brijigeport ®Miltord 15 Miles |
° n o ?
ilton ~_Stratford .0 15 Kilometers
N°""‘2‘;:i:“lp°" Long Island Sound /{ij Q
° .Stamford L
Creenwich o
.- i R 5 e Connecticut
P AL i NEW YORK — =
&] &

Many of the labels on maps link to other maps
or to related articles. For instance, if you are
viewing the map of North America and you
click the United States label, the map of the
United States opens. If you click on the North
America label, the related article will open.

You’ll know you've found a link because the
pointer changes from an arrow to a hand when
it passes over the label. Try clicking some labels

and see what happens.
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The Parent Map
button takes you to
a map of greater
scope. For example,
clicking it from the
United States map
opens the map of
North America, and
from there you can
open the map of
The World.

2.2,
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MNorth America s the larger of the two continents of the Wastern Hemisphere  The
main body of this somewhat rectangular continent is extended In the northwest by
the peninsula of Alaska and its Aleutian Island chain, in the northeast by the
world’s largest island (Greentand), in the southeast by Florida's peninsula, and in
the southywst by Mexico and the iand bridge to South America. In addition, the
Caribbean islands are also often included in the physical definition of North
America Alogether, the continent’s land area places tthird In size among the
seven continents, smaller only than Asia and Africa

Alternative defintions of North America are aiso made on political or cuRural
grounds. Greenland, under Danish sovereignty and virtually without permanent
human sedtlement, is often considered an extension of Europe  The small
countries occupying the namow isthmus between Mexico and South America may
be treated separately as CENTRAL AMERICA. The Carbbean islands may be
combined with Mexico and Central America and described, collectively, as
Middie Amenca

In the broadest defintion, North Amenica extends across $,300 km (3,300 mi) from
St John's, Newfoundland, to the Pacific coast of Washington’s Olympic
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Traveling through time

Timelines offer you the ability to explore the

chronological relationship between

events.

Select an age of interest, and the timeline for
that age appears. Begin by clicking the
Timelines button on the toolbar to open the

timeline selector.

click for Event List

eSS Top Time Line =
£ - TIiD Sl v

|

b
ORIGINS
ANCIENT

|
CIVILIZATIONS

yEun
A WORLD OF
OF SCIENCE
REASON, RIGHTS

S DARKNESS & LIGHT
. AWAKENINGS

ey o

o' F
)
| P

2
o)
y
L
‘e~
T~
o
Sy
ey
-
N

THE TRIUMPH
& REVOLUTION
;1 THE MACHINE AGE
THE WORLD AT WAR ! <

=
-

click for timeline
instructions

TOWARD A NEW |18

GLOBAL OUTLOOK

click any column to see
timeline for that age

The timeline selector is used to pick one of the
10 timelines. A single click on any timeline
replaces the timeline selector with the chosen
timeline. If you're interested in finding a

particular event, and you know the

year in

which it occurred, click the time scale to
present the Event List instead of viewing a
timeline. The Event List is discussed below, so

for now open a timeline of interest.

10-Minute Tour
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click for Event List ‘ o
click for timeline selector

click for Knowledge Explorer

click for survey article
=& s

L l"'l"'l"""'l'"""l"'l

| .
click for - 17000.1710 1720 1730 1740 1750 1760 1770 1780 click for
previous : next :
timeline timeline

Slav Abolitienists * Antisla
& Human Rights momthv:

click for
event
description

Timelines graphically display the chronological
relationship of important events in the history
of the world. Civilizations and major societal
transformations are shown as bars to indicate
their duration. One-time events are represented
by small pictures. Click an item of either type to
view a brief description of it.

You can switch to the next timeline by clicking
the arrow icons at the ends of the time scale.

Clicking on the time scale opens the Event List
with the event closest to the clicked date
automatically selected.

enter year here click appropriate era
=== [uent List
7

Date to Find
[ 17501 @{a.c. QO AD.

1750 - American frontiersman Christopher Gist
explores the Ohio River region

1750 - Baal Shem Tov founds the Jewish sect of
Hasidism about this time

1750 - Poona becomes the capital of the Maraths
confederacy in India

1750 - The Afshars are replaced by the Zand dynasty
in Persia (Iran); Shiraz becomes the capital

1750 - The Conestoga wagon develops in
Pennsylvania about this time

1750 - The neoclassical movement in art develops in
Europe about this time

[ clear | | view |

click to open selected item

The Event List is used to select events based
upon the year they occurred. The Event List
works just like the Article Title List, with the
addition of the radio buttons for selecting the
appropriate era. When you see an event in
which you're interested, double-click it to open
a list of related articles, or select it and click
View. Once you open an article, you can
continue exploring since you already know
what to expect when you click the buttons on
the button bar.

10-Minute Tour
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Pathmakers

The Pathmaker Gallery is a new addition to the
GME that adds an aspect of serendipitous
exploration by providing an introduction to,
and a launching off point for, a group of articles
that are related in less-than-obvious ways.

Click the Pathmakers button on the toolbar to
open the Pathmaker Gallery.

[===========" Pathmaker Gallery5——=="12

s
BN i ’A

k GREAT THINKERS )
N THE NOVEL AND
4 INNOVATORS rR(A):?IEI:\‘()I THE AMERICAN
AND INVENTORS
KNOWLEDGE ENPERIFINGE

facCready
Jay Gowuld

(7

kers

» Kurit Vounegul, Jr.

S
-
S
=
—
~

THE ARTIST EXPLORERS AND GREAT SPORTS
IN THE THE HORIZONS ACHIEVEMENTS
MODERN ERA OF DISCOVERY OF HISTORY

» Jackie Joyner-Kersee

click name for click text for click picture
article on speaker list of articles for video

The Pathmaker Gallery is used to choose from
among six topics, each comprising a group of
related articles. Videos of notable personalities
introduce each topic. Clicking any of the six
pictures in the Pathmaker Gallery opens the
chosen video in the same type of window used
for the Multimedia Map you saw earlier in the
tour.

10-Minute Tour

When you’re done viewing a video, click the
person’s name to view an article about him or
her, or click any of the six title buttons to
display an article drawn at random from that
group. Once the article appears, it acts just like
all others with the exception that it has a
Pathmaker button on the button bar, indicating
that it is part of a Pathmaker group. Click this
button to present a list of other articles drawn
randomly from that group.

[fO======—=—==3 pathways

Below are five ai’tlcles related to the
Pathmaker subject you chose.

- Click a title for a brief description; then click
! Uiew to open that article.

| Ta choose another subject, click Gallery.

Piet Mondrian
vorticism click to hear
Jaques Louis David a fact about
Salon the article
Diego Rivera

Cancel j | Gallery | I View I

click to return to the

click to open the selected article
Pathmaker Gallery

and hear an explanation

The Pathmaker dialog box contains a list of five
articles, drawn randomly from the articles in
the selected Pathmaker group. Click any of the
titles in the scroll box to hear a fact related to
the article. If it interests you, click View to open
the article and hear a longer explanation of its
significance to the subject.
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Moving on

Congratulations! You've finished the guided
tour and should now have a pretty good
understanding of how to explore everything the
GME has to offer. You've learned how to look up
specific articles by their titles, search for items
containing particular words, listen to sounds,
view pictures, play videos, explore maps, travel
through time, and much more. Now that you
know the basics of working with the GME, you
can explore at your leisure. Detailed
instructions for using some of the more
powerful features in the GME can be found in
the rest of this User’s Guide.

Chapter 3:
Research

Tools and
Techniques

After completing the 10-minute tour in

Chapter 2, you should feel comfortable
navigating through the GME and using the basic
tools. However, some topics were intentionally
avoided because they are a little more
complicated. This chapter contains in-depth
explanations of advanced Word Search
techniques, using bookmarks to keep your place
in the GME, working with a word processor,
copying and pasting, and printing and saving.
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Avoid searching for
common words
such as “for,”
“he,” and “the.”
Such words, called
stop words, are
ignored because
they occur so
frequently that they
would cause a
search to find far
too many articles to
be useful. The
complete list of stop
words is located in
Appendix B.

30

Advanced Word Search techniques

The Word Search dialog box is one of the most
powerful tools in the GME. As its name implies,
it can be used to locate articles and other items
containing particular words or phrases. In its
Fewer Choices form, the Word Search dialog
box is pretty much self-explanatory.

enter the word(s) to locate click to expand this dialog box
|

E0] Word Search

Text to Find

"l commedia dell ‘arte | IMM
I nelp.TI I Reset l I Cancel ] l Find I

click toopena click to clear click to close click to display
Help window the Text to  this dialog box a list of items
explaining the  Find box without initiating  that meet the
options in this the search search criteria
dialog box

To begin locating items, enter text in the Text to
Find box. The simplest search is for a single
word, but you can enter multiple words, in
which case the GME searches for an exact match
of the entire phrase, ignoring capitalization.

Wild cards

Many searches can be made more fruitful by
casting the net a bit wider to get a related group
of words. For example, suppose you want
articles on the Danish fairy-tale author Hans
Christian Andersen, but you don’t know if his
last name is spelled Andersen or Anderson. Sure,
you could perform two separate searches for
each of the different spellings, but why bother?
With wild card characters, you can find articles
without knowing the exact spelling.

Just as the jokers can act as any card in a game
of poker, the wild cards ? and * can represent
any character or characters in the Word Search
dialog box. Specifically, the question mark is a
wild card for a single character, whereas the
asterisk signifies any number of characters.

In our example, enter Anders?n and click Find
to locate articles containing either spelling of
the last name. On the other hand, if you enter
Anders*, not only do you get articles
containing either spelling, but you also see
articles on the Confederate Army’s notorious
Andersonville Prison, and everything else that
begins with “Anders.”

The asterisk wild card is also helpful for locating
articles containing root words. For example, if
you're writing a report on education, you may
want to search for articles that include any of
the following terms: education, educator,
educate, educated, educates, educating, and
educational. Since all these words begin with
the same six letters, they’re perfect candidates
for searching with the asterisk wild card. If you
enter education and click Find, the GME will
locate many articles with that word. But if you
enter educat* instead, it finds even more
articles with that root.

Use the question mark wild card carefully; it
stands for one and only one character. For
example, the search for village? finds “villager”
and “villages,” but misses “village.”

The asterisk wild card is more flexible; it stands
for any number of characters, including none.
For example, the search for ro*te finds “rote” as
well as “route” and “rotate.”

Research
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Placing a comma
between words is
the same as
separating them
with the “or”
operator.

32

Operators

There are three common words that have
special meaning in the Word Search dialog box.
The words “and,” “or,” and “not” are standard
Boolean operators that broaden or narrow
searches, depending on their use.

The “and” operator is perhaps the easiest to
understand. If you enter Lincoln and slavery,
only articles containing both words are found.
But you aren’t restricted to pairs of words. You
can also search for Lincoln and slavery and Civil
War, if you wish. The more words you add to
the search criteria, the more narrow your focus
and the fewer articles you’ll find. That may be
what you want if your initial search yields too
many articles to be useful, but avoid narrowing
the search to such a degree that you overlook
important references to your topic.

The “or” operator is also pretty easy to figure
out. It’s useful when you’re unsure of what
words an author may have used to describe a
particular topic. For example, suppose you're
interested in nuclear weapons. If you enter
nuclear or atomic, articles containing either
word are found. The more alternative words you
add to the search criteria, the broader the search
and the greater your chances of finding what
you want. Just don’t specify so many
alternatives that you end up with more articles
than you could possibly read.

The “not” operator is perhaps the most difficult
to understand at first, but once you see it in
action, it makes perfect sense. It’s useful when
you want to exclude certain words to narrow
your search. For example, if you want
information on the 16th-century German
theologian Martin Luther, you might search for
Martin Luther. However, this finds lots of
articles, many of which deal with Martin Luther
King, Jr., the 20th-century civil-rights leader. To
eliminate these articles, enter Martin Luther not
Martin Luther King, then click Find. The GME
searches for all articles containing the phrase
“Martin Luther,” then drops all of the articles
that contain the phrase “Martin Luther King.”

You can combine operators in a single search by
using parentheses, and you can even
incorporate wild cards. For example, enter (iron
or steel) not (Pennsylvania or Pitts*) to find all
articles containing “iron,” “steel,” or both
words, then exclude articles containing the
word “Pennsylvania” or any words starting with
the string “Pitts.” If you find the use of
parentheses confusing, click More Choices to
expand the Word Search dialog box.

Research
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More Choices

D= lordscarch |
rText to Find

[steer | [rewerchoices]
|or ‘[Lt_l [_"P" S l ‘Word Pr

O Within Ssme Article
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7777 | @within[  [2] words apart
[or %] | 4~ _ 1§

[ Related Concept Searching

rScope of Search

[¥]Article Text [X]Titles [X]Fectboxes  [X|Captions  [X]Maps

[ Heip..| [ meset | [ cancer| [ Fina |

The additional text boxes in the More Choices
form of the Word Search dialog box allow you
to construct the same sort of complex searches
as are possible with operators and parentheses
in the Fewer Choices form, but the layout
makes it easier to understand.

Using our same example, enter iron in the first
Text to Find box, then press Tab three times to
move the cursor to the second text box. Notice
that as soon as you start entering steel, the
word AND appears in the operator drop-down
list box. That’s the default operator for creating
a complex search. Click the arrow to open the
box, and select OR. Tab down to the next text
box and enter Pennsylvania or Pitts*. Change
the AND operator in the box to the left of it to
NOT by selecting NOT. When you have entered
everything as shown, click Find and you should
get the same results as when you used
parentheses in the Fewer Choices form.

The More Choices form of the Word Search
dialog box adds the following options to the
Fewer Choices form.

Word Proximity

By default, the GME looks for two or more
search words in the same article, no matter how
far apart they are. However, this might result in
finding articles that just happen to contain the
words but aren’t really relevant to your search.
Logic tells us that the closer together two or
more words appear in an article, the more likely
they are related to one another.

Click the Within radio button and enter a
number to specify how far apart the words may
be and still be considered valid. The words must
be no more than the specified number of words
apart, in any order. This applies to all the words
entered, so the first word must be within the
range of the second, and the second within the
range of the third, etc.

Related Concept Searching

To expand your search to include related ideas,
topics, or concepts, mark the Related Concept
Searching checkbox. When this option is
selected the GME performs your search, figures
out other words (topics or concepts) that might
also be relevant, searches for those topics and
arranges the results list in order of their
relevance to your search.

[t is important to remember several things when
using Related Concept Searching. First, this
option is designed to expand your search, so it
is likely that you will get a greater number of
articles with this option than without it.
Second, because Related Concept Searching is
much more sophisticated, it will take longer to
get the results than will a regular search, so be
patient. Third, when you select this option, the
GMEwill try to figure out other words that

Research
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might also be meaningful, but while in many
instances it might turn up items that you are
interested in, in others the additional articles
might not be helpful.

The best way to understand how Related
Concept Searching works is to try it. Create a
search that finds articles that you are interested
in. Initiate the same search with the Related
Concept Searching option selected. Compare
the results.

Scope of Search

By default, the GME searches for your words in
the text of articles, titles, Factboxes, captions,
and maps. However, you can ignore any of these
sources by unmarking the appropriate
checkboxes.

Tools for finding related articles

The GME provides several ways to easily jump
around the encyclopedia so that you may follow
your interests wherever they lead.

Word Search on Selection

One way to search for a word is to highlight it
in a window (click and drag a phrase or double-
click a single word), then click the Word Search
on Selection button on the toolbar. This
initiates a search for that selection just as if you
had typed it into the Fewer Choices form of the
Word Search dialog box. After searching on a
selection, the Search Results window appears.

Hyperlink to Selection

Many GME articles contain words that appear in
ALL CAPS. Most of these are titles of other
articles, and the GME provides an easy way to
open these articles. Highlight the word or

phrase in a window (click and drag a phrase or
double-click a single word), then click the
Hyperlink to Selection button on the toolbar.
The Title List opens with the selection in the
Title to Find text box and the closest match
selected in the scroll box.

Search Timeline for Selection

Just as you may search the Article Title List for
the closest match to a word selected in an
article, so may you search the Event List for the
closest match to a year that appears in an
article. Suppose you're reading the article on the
Battle of Hastings and you begin wondering
what was going on in the world at the same
time. Highlight the year 1066 by double-
clicking it in the article, then choose Search
Timeline for Selection from the Find menu. The
Event List appears with the selected date
entered in the Date to Find text box and the
closest match highlighted in the scroll box.

Bookmarks

If you come across an article you want to return
to later, you can add a bookmark to the GME
just as easily as you can a printed encyclopedia.

Bookmarks point to particular articles and a
cursor position inside the article. They allow
you instant access to the articles without having
to go through the series of steps that brought
you to the window in question.

Bookmark information is stored in files called
bookmark lists. When you first launch the GME,
an untitled bookmark list is automatically
created.

Research

Not every word in
all caps is an article
title. Section
headings,
abbreviations, and
acronyms may also
appear in all caps.
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Adding bookmarks

You can add to the current list by clicking the
Add Bookmark button on the toolbar (the
frontmost window must be an article window,
otherwise the button is dimmed).

Please give the bookmark a name:

Brochen  ~iwz s e )
[Tancel] l[ 0K ]]

The default name for a bookmark is the name of
the current article. However, you may change
this if you wish. This allows you to create
multiple bookmarks for a single article. When
the name in the text box is acceptable, click OK
or press Return. If you don’t want to add a
bookmark after all, click Cancel.

If you try naming a bookmark using an existing
name, an alert box appears to that effect.

Replace existing bookmark with the
same name?

Click Yes to replace the old bookmark. Or click
No to return to the previous dialog box, where
you can enter a different name and try again.

Once you have added a bookmark, it appears at
the bottom of the Tools menu. Choosing a
bookmark from the Tools menu opens the
related article and places the cursor where it was
when you created the bookmark.

You may create as many bookmarks as memory
allows, although as a practical matter more than
a handful can be confusing since they are listed
in the order they were added to the list, not
alphabetically.

Removing bookmarks
To delete a bookmark, choose Remove
Bookmark from the Tools menu. A window

appears listing all of the current bookmarks in a
scroll box.

5= Remove Bookmarks =l
Current List: Legal terms

Chivalry

Common Law

Constitutional Law

Courts

Crime and Criminology

Customs

Ideology

Muythology

Punishment

Restitution

Restraint of Trade

Slavery

Sovereignty

| opetete | [ cancer |

Select a bookmark, then click Delete to remove
it. When you’re finished making changes, click
the close box, or click Cancel to revert back to
the bookmark list as it existed when this dialog
box was opened.

Saving and opening bookmark lists

[f you have made changes to a bookmark list (by
adding or editing bookmarks), the GME prompts
you to save your changes to disk upon quitting
the application or changing bookmark lists.

Save changes to current bookmark list?

| ves )] ( No ] [(cancer)

Research
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The GME defaults
to opening the
same bookmark list
last used with the
application. If the
GME can't find it, it
opens a standard
file selection dialog
box asking you to
locate the
bookmark list file or
create a new list.

a0

Click Yes and a standard file selection dialog
box allows you to specify the name and location
of the bookmark list file. If you don’t want to
save the changes, click No. To return to the
GME without quitting or opening a new list,
click Cancel.

Multiple bookmark lists are allowed, so you can
have different lists for different research
projects or different users. However, only one
may be open at a time. To open an existing list,
choose Open Bookmark List from the File menu.
To create a new list, choose New Bookmark List
from the File menu. In either case, if the
existing list has been changed, you're prompted
to save the changes before the new list is
opened.

Opening an existing list opens a standard file
selection dialog box for you to locate the
desired list. Creating a new list doesn’t appear
to do anything, but you’re prompted to save
upon quitting if you add any bookmarks. If you
don’t add anything to a new list, it’s not saved.

Working with a word processor

As you explore the GME, you may find
information that you would like to incorporate
into a report, homework assignment, business
letter, or other document. The GME offers the
ability to launch your word processor so you
can paste and edit items using a full-featured
application with which you're already familiar.

Launching a word processor

Before you can launch your word processor
from within the GME, you must tell the GME
where it’s located. The first time you click the

Word Processor button on the toolbar, the GME
opens a dialog box asking you to specify the
location of your preferred word processing
application.

Where's the word processor you wish to use?
€I MS Word ¥ © Power Mac HD
% Microsoft Word
O Sample Documents Desktop
[ Settings Files
0O Word Commands
I Open I

Only volumes, folders, and applications appear
in the file selection dialog box. Once you see
the application you wish to use, double-click its
name or select it and click Open. The GME
launches the application you specified and
remembers its location so that you needn’t
relocate the application the next time you click
the Word Processor button on the toolbar. (If
you don’t have a full-featured word processor,
you can always use TeachText or SimpleText,
two text editors that come with your Macintosh
System software.)

[f you make a mistake in choosing the word
processor, or if you want to change it for some
other reason, you may do so by choosing
Preferences from the Edit menu and clicking the
Choose Word Processor button.

If the GME can’t locate the specified application
when you click the Word Processor button on
the toolbar (perhaps you’ve moved the
application or changed its name), it alerts you
to the problem and opens a file selection dialog
box asking you to relocate it.

Research

The GME doesn't
verify that you have
chosen an
appropriate type of
application for word
processing. If you
specified an arcade
game as your word
processor, that's
what the GME
launches when you
choose this
command.
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Copying and editing
You may copy articles from the GME and paste
them into other applications. Here’s how:

To copy text from the GME to the Clipboard,
first select it by positioning the cursor over the
start of the passage you want, then click and
drag to extend the selection over the desired
material. If you want to highlight everything in
the current window or text box, choose Select
All (Command-A) from the Edit menu. Once
text is selected, choose Copy (Command-C)
from the Edit menu to place it on the
Clipboard. Click the Word Processor button on
the toolbar to launch or switch back to your
word processor, then choose Paste (Command-
V) from your word processor’s Edit menu. Once
material from the GME is in the document, you
may use all of the standard commands offered
by your word processor.

Whenever you copy, print, or save GME
material, a copyright notice is automatically
added because the material in the GME is
copyrighted, as are most published materials. It
is unlawful and unethical to take someone else’s
words and use them as your own. However, it is
quite acceptable for you to quote from the
encyclopedia and give proper credit in a
footnote or other type of reference. Include the
author’s name (if available), the article’s title,
and Grolier Multimedia Encyclopedia, copyright
© 199S Grolier Electronic Publishing, Inc.,
Danbury, CT.

Printing and Saving

Most items in the GME can be printed or saved
to disk by clicking the appropriate toolbar
button or choosing the desired command from
the File menu. If an item may not be printed,
the buttons on the toolbar are dimmed, as are
the Print and Save commands in the File menu.

Printing

Before printing for the first time, it’s a good idea
to choose Page Setup from the File menu to
open the standard Page Setup dialog box for the
current printer.

Laserlriter Page Setup 712 m
Paper: @ US Letter O R4 Letter .
OUS Legal O BS Letter & [_Tabloid | ((cancer )
Reduce or Printer Effects:
Enlarge: [ Font Substitution?
Orientation (] Text Smoothing?
Graphics Smoothing?
“Jll] Faster Bitmap Printing?

Research
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Text is saved in
unformatted text
files that can be
opened by any
word processor.
Maps and pictures
are saved as files
that can be opened
by most graphics
programs.

a4

Make whatever changes you like to the available
options then click OK to accept them, or click
Cancel to revert to the original state.

Once you’re satisfied with the Page Setup, make
sure the desired window is the frontmost
window by clicking on its title bar, then click
the Print button on the toolbar to open the
standard Print dialog box.

LaserWriter “LaserWriter” 712 m‘
Eopies:@ Pages: @ All O From: L_] To: |__|
Cover Page: @ No O First Page O Last Page

Paper Source: @ Paper Cassette (O Manual Feed

Print: @ Black & White O Color/Grayscale
Destination: @ Printer O PostScript® File

If you want to print a page range, you can enter
it in this dialog box, but if you want to print
only a selection from the current window, click
Cancel, then choose Print Selection from the
File menu.

Saving

Clicking the Save button on the toolbar opens a
dialog box asking whether you want to save the
entire current window or a selection. (If there
was no selection in the current item, this dialog
box is bypassed.) After specifying what you
want to save, a standard file save dialog box
appears, allowing you to specify the name and
location for the file. Click Save to save the item
to disk.

Appendix A
Preferences

The GME comes configured to work a certain
way when you first start using it. However, you
may find that you prefer options other than the
default settings. Choose Preferences from the
Edit menu to open the Preferences dialog box.
There you can change a number of settings.
Whenever you make changes to these settings,
the GME application on your hard drive is
updated so that you needn’t make these
changes again.

=] Preferences e —
Startup Options l 0K l
[ nisplay registration reminder
Display Options AT T AR
[ Show main feature window
(] Show category index windows 5
[ show toolbar at startup

Search Options —

Default proulml(g:E]woms apart

Default word search dialog:
@ Fewer choices (O More choices

The GME does not
create a separate
preferences file in
your System folder.
Instead, it modifies
itself. If you're
running an anti-viral
utility, it may alert
you to an attempt
to change a
resource. This is
normal; just grant
permission to allow
the GME to make
the changes.
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Display registration reminder

The default is for the reminder to appear, but
feel free to turn it off by unmarking this
checkbox after you've registered. To register,
send in your warranty card or call

(800) 285-4535.

Show Main Features screen

The default is for the Main Features screen to
appear when all other windows are closed, but if
it is turned off you can still make the same
choices from the toolbar or the menu bar.

Show category index windows

The default is for category windows to appear
when you click any of the appropriate buttons
on the toolbar or Main Features screen, or if you
choose the appropriate commands from the
View menu. But if the category windows are
turned off, the item’s index window appears.

Show toolbar at startup

The default is for the toolbar to appear when
the application is launched, but it may be
turned off by unmarking this checkbox.

Default Proximity: Words Apart

The default is that multiple words entered in
the Word Search dialog box must be no more
than 10 words apart. Use the up and down
arrows to change the range. The closer together
the words, the more likely they are related to
one another.

Default Word Search dialog

The default is to open the Word Search dialog
box in its Fewer Choices mode, but if you prefer
the More Choices mode, click that radio button
instead.

Word processor button

The first time you click the Word Processor
button on the toolbar, you go through the
process of selecting the name and location of
the word processor that you want to use in
conjunction with the GME. If you want to
change the default application, click this button
to open a standard file dialog box so that you
can specify the location of the new application
you want.

Font

The default font is 12-point Geneva, but if you
choose Font from the Edit menu, a dialog box
appears allowing you to choose any font in your
System. Only article text is affected by this
setting. All other areas where text appears use
the standard system font.

Preferences
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Stop Words

The following “stop words” are excluded from
the Word Search dialog box because they’re too

common to be useful and are therefore ignored.

A
about
across
after
again
all
along
also
although
among
an

any
are
around
as

at

B

be
became
because
become
been
before

begun

being
between
bibliography
but

by

C
called
can
caused

D

developed
development
different

E

each

early

ed

est
established
even

every

F
for
from

G

generally
got

H

had

has
have
he

her
him
himself
his

I

if

in
include

AQ
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included
includes
including
into

is

it

its

K
known

L
later
led

M
made
make
many
most
much
must

N

near
nearby
no

of

on
only
other
over

P
probably

R
repr

S

see
served
several
she

SO
some
soon
such

T

than
that
the
their
them
then
there
thereby
these
they
this
those
though
through
thus

to

took

U
under
until
up
upon
use
used
using
usually

Vv
various

\%Y
want
was
were
what
when
where
which
while
who
whom
whose
why
widely
with
within

Appendix C

Troubleshooting

The following pages give solutions to the most
common problems you may experience while
using the GME. Many other problems with the

GME can be solved by reinstalling the program
as aescribed in Chapter 1.

[f you still need help after consulting this
Appendix, our technical support staff will be

happy to assist you. When you call, please have
the following information ready:

* Macintosh model, amount of memory,
System version (choose About This
Macintosh from the Apple menu)

* Alist of your extensions and control panels
* CD-ROM drive make and model

The nature of your problem; please tell us as
many details as you can about your problem,
including the exact wording of the error
messages, etc.

For technical support hours and phone
numbers, see the Quick Start card or choose
Technical Support from the Help menu.
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Problem:

Solution:

Problem:

Solution:

Problem:

Solution:

After you double-click the Grolier
Multimedia Encyclopedia icon to start
the program, an alert box appears
indicating that the GME can't find
the needed files on the CD-ROM.
Make sure you have inserted the
GME9S disc in your CD-ROM drive.
Make sure your CD-ROM drive is
properly plugged into a working
outlet, the drive is turned on, and
the CD-ROM extensions are properly
installed in the System folder.

When you attempt to perform an
operation, an alert box appears
indicating that all available memory
has been exhausted.

There is not enough memory
available to perform the operation
requested. Once the program has
quit, locate the Grolier Multimedia
Encyclopedia icon in the Finder. Click
once on the icon to select it, then
choose Get Info from the File menu.
In the lower portion of the Get Info
window, increase the Application
Memory Size to at least 2048K.

The Animation and Video buttons
are dimmed on the toolbar and
button bar.

Check that QuickTime 2.0 or later is
installed in your System folder. If
not, drag the QuickTime extension
from the CD-ROM to the System
folder on your startup volume.

Problem:

Solution:

Problem:

Solution:

Troubleshooting

An error message appears when you
try to print.

Make sure your printer is properly
plugged into a working outlet, the
printer is turned on, and the print
driver extensions are properly
installed in the System folder. If you
are using a network printer, choose
Chooser from the Apple menu and
reselect the printer. If the printer
doesn’t appear in the Chooser, the
network connection is suspect and
should be fixed. Printing will also
not function if you do not have
enough free hard drive space.

Everything appears in black & white
on a color monitor.

Choose Control Panels from the
Apple menu, then double-click the
Monitors control panel. Make sure
the selected monitor is set to display
a minimum of 256 colors.

[ ~%o |
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Appendix D

Menus

File menu
New Bookmark List

Open Bookmark List

Close

Save

Page Setup...

Print Selection

Print...

Quit

Edit menu

Undo

Cut

Creates a new bookmark list. If the current list
has been changed, you're prompted to save
the changes before the new list is created.

Allows you to locate the existing bookmark
list that you wish to open. If the current list
has been changed, you’re prompted to save
the changes before the new list is opened.

Closes the active (frontmost) window and its
offspring, if any.

Allows you to specify the name and location
of a file to which you may save a selection or
the entire contents of the current window.

Opens a dialog box allowing you to change
the default options for the current printer,
such as paper size, orientation, etc.

Prints only the selected portion of text, not
the entire window.

Opens a dialog box allowing you to specify
the number of copies, page range, etc. before
continuing to print the entire window.

Closes all open windows, prompts you to save
changes (if any) to the current bookmark list,
exits the GME, and returns you to the Finder.

Reverts the current window to its state prior
to the previous Edit command. Does not undo
other actions.

Removes selected text from a text box and
places it on the Clipboard. The contents of
the Clipboard may be pasted into documents
created by other applications, such as word
processors.
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Copy Copies the selected text to the Clipboard. The
contents of the Clipboard may be pasted into
documents created by other applications,
such as word processors.

Paste Inserts contents of Clipboard (text only) into
a text box.

Clear Deletes the contents of the current text box.

Select All Highlights everything in the current window.

Font... Allows you to choose the default font and size

used in article windows.

Preferences... Allows you to change the default settings for a
variety of options that affect how the GME
works.

View menu

Article Title List Opens the Article Title List.

Multimedia submenu

Maps Opens the Map Categories window.

Multimedia Maps ~ Opens the Multimedia Map Categories
window.

Pictures Opens the Picture Categories window.

Sounds Opens the Sound Categories window.

Videos Opens the Video Categories window.

Animations Opens the Animation Categories window.

Knowledge Explorer Opens the Knowledge Explorer Categories
window.

Pathmakers Opens the Pathmaker Gallery window.

Opens the Knowledge Tree Categories
window.

Knowledge Tree

Atlas Opens the interactive World Map.

Timelines Opens the Timeline Selector window.

Toolbar Toggles the vertical toolbar on (checkmark)
and off. The toolbar is a palette that floats in
front of all other windows so it's always
available, expect when the Main Features
screen appears.

Caption Toggles the current window’s caption open

and closed (checkmark).

Find menu
Word Search...

Hyperlink
to Selection

Word Search
on Selection

Search Timeline
for Selection

Tools menu
Word processor...

Add Bookmark...

Remove Bookmark...
I...n Bookmark
Window menu
Cascade

Close All

l...n Open Window

Opens the Word Search dialog box.

Opens the linked article on the selected
subject (titles of linked articles appear in ALL
CAPS in article text). If the selection is
incomplete or not the title of a linked article,
the Title List appears with the selection in the
Title to Find text box and the closest match
selected in the scroll box.

Searches for items containing the selected text
using the Word Search dialog box’s Fewer
Choices settings and opens the Search Results
window.

Opens the Event List with the selection in the
Date to Find text box and the closest match
selected in the scroll box.

Launches or switches to the word processor
previously defined. If the default application
can’t be found or hasn’t been defined, a
dialog box opens in which you can specify the
application to use.

Opens a dialog box in which you can name a
bookmark and add it to the current bookmark
list.

Allows you to remove bookmarks from the
current bookmark list.

Opens the article indicated by the bookmark

and positions the cursor where it was when
the bookmark was created.

Arranges open windows in stair-step fashion
from the upper left corner of the screen.

Closes all open windows.

Brings the chosen window to the front.

Menus
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Help menu
Registration

& Support
Quick Start

Navigating through
the GME

Searching

Articles
Pathmakers
Timelines
Multimedia Players
Tools

Contributors

Copyrights

Acknowledgements

Opens this help topic.

Opens this help topic.

Opens this help topic.

Opens this help topic.
Opens this help topic.
Opens this help topic.
Opens this help topic.
Opens this help topic.
Opens this help topic.

Lists the names and affiliations of the writers
of many of the articles in the GME.

Lists copyright information.

Lists the names of the people responsible for

producing the GME.

Appendix E

Buttons
and icons

Button bar

Button bar buttons indicate the multimedia
items linked to an article. Click these buttons to
open an item or list of items related to an

article.

QOutline

Tables

Factbox

Pathmaker

Maps

sl lefm]

Knowledge
Explorers

Animations

Videos

Pictures and Sounds

Multimedia Maps
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QuickTime buttons

The GME uses QuickTime technology to play
sounds, animations, videos, Multimedia Maps,
Knowledge Explorer essays, and Pathmaker
videos. The last three items appear in extended
windows with tables of contents, but the
standard QuickTime controls are still used.

opens opens list of
caption window linked articles

Germpifii space walk =05

play/pause play bar rewind
volume fast forward

List icons

type of item in the list. The complete set of
icons follows.

Article

8§ Picture

‘) Sound

S Video

F2| Factbox

@ Map

@ Multimedia Map
E Animation

List windows contain small icons indicating the

Index

Symbols
* wild card
? wild card
10-Minute Tour 5

A

31
31

About This Macintosh 51

Academic American Encyclopedia

Acknowledgements 58
Add Bookmark 8, 38, 57
Advanced Word Search 30

age 23

ALL CAPS 36, 57

and operator 32, 34
Animations 15, 16, 52, 56, 60
anti-viral utility 45

any number of characters 31

Apple menu

51, 53

Application Memory Size 52
\pplications menu 42
arrow 21

Article Title List 8, 9, 11, 18, 25, 37, 56, 57
10,

articles

36, 42

Articles button 15, 18

asterisk

B

bars 24

31

black & white 53
bookmark
bookmark list 37, 40, 55, 57
Boolean operators 32

broaden or narrow searches

37-40

Browsing article titles 8
button bar

buttons

59

10, 14, 25, 27, 59

32

1,.2

C

Canadian provinces 15
can’t find the needed files 52

capitalization 12, 30
captions 16, 36, 56
Cascade 57

case-sensitive 12
categories 19, 20
category windows 19, 46
CD-ROM drive 2-4, 51, 52
Choose Word Processor 41, 47
Chooser 53
chronological relationship 23, 24
Civilizations 24

Clear 56

click and drag 42
Clipboard 42, 55, 56
Close 55

Close All 57

comma 32

common words 30
Contents 58

continents 15
Contributors 58

control bar 16

control panels 51, 53
copies S5

Copy 42, 43, 56
copyright notice 43
Copyrights 58
countries of the world 15
Cut 55§

D

Date to Find text box 37, 57

default font 47

default settings 56

Default Word Search dialog 47

dimmed commands 8, 13, 42, 52

disc 4

Display Category Windows checkbox
46

Display Main Features screen 46

Display registration reminder 46

19,
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E

Edit menu 7, 19, 41, 42, 45, 47, 55
era 2§

error messages S1

Event List 23, 25, 37, 57

events 23

exploration 26

exploring the globe 19

extended windows 18

extensions 4, 51, 52, 53

F

Factbox 14-16, 36

fast forward 18

Fewer Choices 30, 34, 36, 47, 57
File menu 40, 43, 44, 52, 55
Find menu S7

Finder 5§

finding related articles 36

Font 47, 56

For the System Folder 4

G

Geneva 47
Get Info 52
GME95 4
graphics 42
group 27
guided tour §

H

hand cursor 21

hard disk 3

headings 10, 18

help 5, 51, S8

Hyperlink to Selection 8, 36, 37, 57

icons to the left of the names 15
ignored 30, 49
index window 19, 20, 46

K

Knowledge Explorer essays 18, 56, 60
Knowledge Tree 56

L

labels on maps 21

link 21

list icons 60

list windows 15, 60

looking at multimedia items 14

[~

M

Main Features screen 6, 7, 8, 46, 56
Map Categories window 19

Maps 15,19, 22, 36, 42, 44, 56
memory 3, 51, 52

menu bar 46, 55

monitor 3, 53

More Choices 12, 33, 34, 47
Multimedia submenu 56

Multimedia Map 14, 17, 18, 26, 56, 60

N

names of every article 9
New Bookmark List 55
North America 21

not operator 32, 33

(0

occurrences of your search words 13
one character wild card 31

one-time events 24

Open Bookmark List 40, 55
operators 32-34

or operator 32, 34

orientation 5§

outline navigation system 20
Outlines 10, 11, 14,

P

package contents 2

page range 55

Page Setup 43, 44, S§

paper size 5§

Parent Map button 22
parentheses 33

Paste 42, 56

Pathmakers 2, 18, 26, 27, 56, 60
pause 18

Pictures 14-16, 42, 44, 56, 60
Play button 16, 18

plus sign 20

pointer 20, 21

Preferences 7, 19, 41, 45, 56
Presidents 15

Print 8, 43, 44, 53, 55

Print Selection 44, 55
printers 3, 5§

problems 51

provinces 15

Q

question mark 31

Quick Start card 51
QuickTime 3, 4, 16, 52, 60
Quit 5§

quoting from the GME 43

R

refining your search 12
registration reminder 2, 6, 7, 46
reinstalling 51

related articles 21

Related Concept Searching 35, 36
Remove Bookmark 39, 57
requirements 3

Research Tools 29

rewind 18

root words 31

S

Save 8, 43, 44, 55

saving bookmark lists 39

Scope of Search 36

Search Results 12, 36, 57
Search Timeline for Selection 37, 57
search words 13

searching for words and phrases 11
segment 18

Select All 42, 56

SimpleText 41

single character wild card 31
small pictures in timelines 24
societal transformations 24
solutions 51

Sounds 15, 16, 56, 60

speaker icon 16

Speed Scroll 9

spelling 31

standard QuickTime window 16
States of the USA 15, 19
statistics 14

stop words 30, 49
subcategories 20

System folder 45, 52, 53
system requirements 3

System version 3, 51

T

Tab 34

Index

table of contents 17, 18, 60

Tables 16

TeachText 41

technical support 51
text files 44

Text to Find box 12, 30,
The World 19

time scale 24, 25
timeline selector 23, 56
Timelines 2, 23, 24, 56
Timelines button 23

34

Timelist see Article Title List

Title List 8, 9, 11, 18, 25, 37, 56, 57

Title screen 6, 46

Title to Find text box 9, 37, 57

titles 36

toolbar 7, 8, 46, 56
Tools menu 38, 57
traveling through time 23
troubleshooting 51

U

U.S. Presidents 15
U.S. states 15
Undo 55

United States 21

United States of America 19

V

VCR controls 18

Videos 15, 16, 27, 52, 56,
View menu 8, 46, 56
volume 16, 18

w

warranty card 2, 46
What's new? 2

wild cards 30-34
Window menu 17, 57
Within radio button 35

Word Processor 8, 40-42, 44, 47, 55-57

Word Proximity 35

60

Word Search 11-13, 32-36, 46, 47, 49, 57

Word Search on Selection
Words Apart 46

Y

yvear 25

8, 36, 57
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